USER'S MANUAL
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.
©February 2006

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.
AMD Turion™ is a trademark of Advanced Micro Devices, Inc.
SRS is a trademark of SRS Labs, Inc. WOW technology is incorporated under license from SRS Labs, Inc.
Preface

FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (DC Output 20V, 11A minimum).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class I Product
Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   - Do not expose the computer to any shock or vibration.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   - Do not expose it to excessive heat or direct sunlight.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don’t use or store the computer in a humid environment.
   - Do not place the computer on any surface that will block the vents.
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th>Do not turn off the power until you properly shut down all programs.</th>
<th>Do not turn off any peripheral devices when the computer is on.</th>
<th>Do not disassemble the computer by yourself.</th>
<th>Perform routine maintenance on your computer.</th>
</tr>
</thead>
</table>

5. **Take care when using peripheral devices.**

| Use only approved brands of peripherals. | Unplug the power cord before attaching peripheral devices. |
Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

---

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

---

<table>
<thead>
<tr>
<th>Do not plug in the power cord if you are wet.</th>
<th>Do not use the power cord if it is broken.</th>
<th>Do not place heavy objects on the power cord.</th>
</tr>
</thead>
</table>

---

VI
Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Preface

Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
Preface

On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:

- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Preface

Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.
Preface

Contents

Notice .................................................................I
FCC Statement ...................................................II
Instructions for Care and Operation .......................IV
Power Safety ......................................................VI
Battery Precautions ..........................................VII
Cleaning ............................................................VIII
Servicing ..........................................................VIII
Travel Considerations ........................................IX

Quick Start Guide

Overview ..........................................................1-1
Advanced Users ...............................................1-2
Beginners and Not-So-Advanced Users .................1-2
Warning Boxes .................................................1-2
Not Included ....................................................1-2
System Software ................................................1-3
System Startup ..................................................1-4
System Map: Top View with LCD Panel Open ........1-5
LED Indicators ..................................................1-6
AP-Key Buttons ...............................................1-7
3D Ap-Key Button .............................................1-7
Function Keys & Numeric Keypad .........................1-7
System Map: Front & Rear Views .........................1-9

System Map: Left View ........................................1-10
System Map: Right View .....................................1-11
System Map: Bottom View ..................................1-12
Windows XP Start Menu & Control Panel ..........1-13
Video Features ................................................1-14
Display Devices & Options ...............................1-14
Power Management Features ...........................1-16

Storage Devices, Mouse, Audio & Printer

Overview ..........................................................2-1
Hard Disk Drive ................................................2-2
Optical Device ..................................................2-3
Loading Discs ..................................................2-3
Handling CDs or DVDs ......................................2-4
DVD Regional Codes .........................................2-5
4-in-1 Card Reader .............................................2-6
PC Card Slot ....................................................2-7
Inserting and Removing PC Cards .......................2-7
Auto Mail Checker ............................................2-8
TouchPad and Buttons/Mouse .........................2-10
Audio Features .................................................2-11
Configuring the Infrared Settings for FIR ..........2-12
## Preface

Adding a Printer ........................................................... 2-13  
USB Printer ............................................................... 2-13  
Install Instructions: ................................................... 2-13  
Parallel Printer ........................................................... 2-13

## Power Management

Overview ........................................................................ 3-1  
Advanced Configuration and Power Interface ............ 3-1  
The Power Sources ..................................................... 3-2  
AC/DC Adapter ........................................................... 3-2  
Battery ......................................................................... 3-2  
Turning on the Computer ............................................... 3-3  
Power Schemes .............................................................. 3-4  
System Power Options ................................................... 3-6  
Hibernate Mode vs. Shutdown 3-6  
Stand by Mode vs. Hibernate Mode 3-6  
Stand by ............................................................... 3-7  
Hibernate ................................................................. 3-7  
Configuring the Power Button ....................................... 3-8  
Battery Information ....................................................... 3-9  
New Battery ................................................................. 3-9  
Battery Life ................................................................. 3-9  
Recharging the Battery with the AC/DC Adapter ....3-10  
Proper handling of the Battery Pack 3-11  
Battery FAQ ................................................................. 3-12

## Drivers & Utilities

What to Install ............................................................ 4-1  
Module Driver Installation .......................................... 4-1  
Service Packs ............................................................... 4-3  
Authorized Driver Message ........................................ 4-4  
Version Conflict Message ........................................... 4-4  
Updating/Reinstalling Individual Drivers ................... 4-4  
Driver Installation ...................................................... 4-5  
Manual Driver Installation ......................................... 4-6  
Windows XP ................................................................. 4-7  
Driver Installation Procedure ....................................... 4-7  
New Hardware Found .................................................. 4-7  
Chipset ................................................................. 4-7  
Video (VGA) .............................................................. 4-7  
Audio ................................................................. 4-8  
Modem ................................................................. 4-8  
LAN ................................................................. 4-9  
AP-Key Buttons .......................................................... 4-9  
TouchPad ................................................................. 4-10  
PCMCIA ............................................................... 4-10  
AMD Processor ........................................................ 4-10  
AutoMail Checker ..................................................... 4-11  
Module Drivers .......................................................... 4-11  
PC Camera ............................................................. 4-11  
Wireless LAN .............................................................. 4-11
## BIOS Utilities

- Overview ..................................................5-1
- The Power-On Self Test (POST) ...............5-2
- Failing the POST ........................................5-3
- Fatal Errors ............................................5-3
  - Non-Fatal Errors ..................................5-3
- The Setup Program ..................................5-4
- Entering Setup .......................................5-4
- Setup Screens .......................................5-5
- Main Menu ...........................................5-6
- System Time & Date (Main Menu) .............5-6
- Primary Master/SATA Port 4 (Main Menu) ...5-7
- System/Extended Memory: (Main Menu) ...5-7
- Advanced Menu ......................................5-8
- Advanced Chipset Control (Advanced Menu)5-8
- I/O Device Configuration (Advanced Menu) ...5-9
- Reset Configuration Data (Advanced Menu) ...5-9
- Power On Boot Beep (Advanced Menu) ........5-9
- Battery Low Alarm Beep: (Advanced Menu) ...5-9
- Security Menu .......................................5-10
- Set Supervisor Password (Security Menu) ...5-10
- Password on boot: (Security Menu) ..........5-11

## Boot Menu

- Boot Menu ..............................................5-12

## Exit Menu

- Exit Menu ..............................................5-13

## Upgrading The Computer

- Overview ................................................6-1
  - When Not to Upgrade ...............................6-2
  - Removing the Battery ..............................6-3
  - Upgrading the Hard Disk Drive(s) ..............6-4
  - Upgrading the System Memory (RAM) ............6-6
  - Upgrading the Optical (CD/DVD) Device(s) ....6-9
  - Removing the Video Card(s) .....................6-10

## Modules

- Overview ................................................7-1
  - PC Camera Module ..................................7-2
  - PC Camera Driver Installation ..................7-2
  - PC Camera Audio Setup .........................7-3
  - EMAMCAP .............................................7-5
  - The Wireless LAN & Bluetooth Modules ......7-7
  - Mini-PCI Wireless LAN Module ...............7-8
  - Intel WLAN Driver Installation ................7-9
  - MSI 6833B WLAN Driver Installation .........7-10
  - Bluetooth Module ..................................7-12
  - Bluetooth Driver Installation ..................7-12
  - Mini-PCI TV Tuner Module ......................7-14
Preface

AverMedia Mini-PCI TV Tuner Module .................. 7-15
Installing the AverTV Utility Software .................... 7-15
Installing the Cyberlink Power DVD Software ........ 7-15
Digital TV Broadcast Signal .................................... 7-16

Troubleshooting

Overview ........................................................................ 8-1
Basic Hints and Tips ...................................................... 8-2
Backup and General Maintenance ................................. 8-3
Viruses ........................................................................... 8-4
Upgrading and Adding New Hardware/Software .......... 8-5
Problems & Possible Solutions ...................................... 8-7

Interface (Ports & Jacks)

Overview ................................................................. A-1
Ports and Jacks ........................................................ A-2
Built-In Microphone ............................................... A-2
Card Reader .............................................................. A-2
Consumer Infrared Transceiver ............................... A-2
DC-In Jack .............................................................. A-2
DVI-Out Port ............................................................... A-2
Headphone-Out Jack ............................................... A-3
Infrared (FIR) Transceiver ..................................... A-3
Line-In Jack .............................................................. A-3
Microphone-In Jack ................................................. A-3
Mini-IEEE 1394a Ports ........................................... A-3
RJ-11 Phone Jack .................................................... A-4
RJ-45 LAN Jack ....................................................... A-4
S/PDIF-Out Jack ...................................................... A-4
Security Lock Slot .................................................. A-4
Serial Port .............................................................. A-4
S-Video-In Jack ....................................................... A-4
7-Pin S-Video-Out Jack ...................................... A-4
TV Antenna Jack ..................................................... A-5
USB 2.0/1.1 Ports .................................................. A-5

NVIDIA Video Driver Controls

NVIDIA Video Driver Installation ............................... B-1
3D Ap-Key Button .................................................. B-2
NVIDIA Display Properties ...................................... B-3
  Additional Properties ........................................ B-4
  NVIDIA nView Desktop Manager ....................... B-6
SLI Multi GPU ......................................................... B-8
Display Devices ....................................................... B-9
Attaching Other Displays ...................................... B-10
Display Modes ......................................................... B-12
  To Enable Extended Desktop
    (Windows Display Properties) ......................... B-13
Enabling TV Display .............................................. B-14
Specifications
Processor Types ............................................................ C-2
Core Logic ................................................................. C-2
LCD .............................................................. C-2
Security ............................................................... C-2
Memory ................................................................. C-2
BIOS .............................................................. C-2
Video Card Options .............................................. C-3
Storage Options ............................................... C-3
Audio ....................................................... C-3
Keyboard & Pointing Device ......................... C-3
PCMCIA ............................................................. C-4
I/O Ports ............................................................. C-4
Communication ............................................. C-4
Operating Systems Supported .................... C-5
Power Management ........................................ C-5
Power ............................................................. C-5
Environmental Spec ........................................ C-5
Physical Dimensions & Weight .................... C-5
Optional ........................................................ C-5
Preface
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

- **Chapter 2** The Storage Devices (hard disk, optical device, Card Reader, PC Card), Mouse, Audio & Printer.
- **Chapter 3** The computer’s power saving options.
- **Chapter 4** The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
- **Chapter 5** An outline of the computer’s built-in software, or BIOS (Basic Input Output System).
- **Chapter 6** Instructions for upgrading your computer.
- **Chapter 7** A quick guide to the computer’s Wireless LAN, Bluetooth, TV Tuner and PC Camera modules (some of which may be optional depending on your purchase configuration).
- **Chapter 8** A troubleshooting guide.
- **Appendix A** A definition of the interface, ports/jacks which allow your computer communicate with external devices.
- **Appendix B** Information on the NVIDIA Video driver controls.
- **Appendix C** The computer’s specification.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may also find the notes marked with a symbol of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a symbol as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.

Not Included
Operating Systems (e.g. Windows XP etc.) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.
Quick Start Guide

System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find this manual refers to the following operating systems:

- Microsoft Windows XP Home & Professional Editions (with Service Pack 2)

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4 - 6. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you), refer to “What to Install” on page 4 - 1 for installation instructions.

Ports and Jacks
See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
Quick Start Guide

System Startup

1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
5. Move and hold the LCD latches in the direction of the arrows to release the top cover.
6. Raise the lid/LCD to a comfortable viewing angle, and press the power button to turn the computer “on”.
7. Adjust the LCD panel to a comfortable viewing angle.
8. The LED indicators show the power and battery status of the computer.

Figure 1 - 1 - Top Panel with LCD Closed

Shutdown

Please note that you should always shut your computer down by choosing the Shut Down/Turn Off Computer command from the Start menu in Windows. This will help prevent hard disk or system problems.
System Map: Top View with LCD Panel Open

1. Optional Built-In PC Camera
2. LCD
3. LED Power & Communication Indicators
4. Speakers
5. AP-Key Buttons & Power Button
6. Built-In Microphone
7. LED Status Indicators
8. Keyboard
9. TouchPad and Buttons
10. Consumer Infrared Transceiver*

*Enabled with Optional Mini-PCI TV Tuner Only

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

The key combination Fn + F11 toggles power to the WLAN module, the Ap-key to the Bluetooth module.

Figure 1 - 2 - Top View with LCD Panel Open
LED Indicators

The two sets of LED indicators (LED Status Indicators and LED Power & Communication Indicators) on the computer display helpful information about the current status of the computer.

Table 1 - 1 - LED Status Indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📷</td>
<td>Green</td>
<td>The (optional) PC Camera is powered On</td>
</tr>
<tr>
<td>📥</td>
<td>Green</td>
<td>The (optional) Bluetooth Module is powered On</td>
</tr>
<tr>
<td>🌟</td>
<td>Green</td>
<td>The (optional) Wireless LAN Module is powered On</td>
</tr>
<tr>
<td>⚡️</td>
<td>Green</td>
<td>Hard Disk Activity</td>
</tr>
<tr>
<td>🔐</td>
<td>Green</td>
<td>Number Lock Activated</td>
</tr>
<tr>
<td>🍀</td>
<td>Green</td>
<td>Caps Lock Activated</td>
</tr>
<tr>
<td>🔔</td>
<td>Green</td>
<td>Scroll Lock Activated (to activate press Fn &amp; Scr Lk)</td>
</tr>
</tbody>
</table>

Table 1 - 2 - LED Power & Communication Indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC/UPS</td>
<td>Orange</td>
<td>DC Power is Plugged In</td>
</tr>
<tr>
<td>🌟</td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td>🌟</td>
<td>Blinking Green</td>
<td>The Computer is in Stand by Mode</td>
</tr>
<tr>
<td>🍀</td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td>🍀</td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td>🍀</td>
<td>Blinking Orange</td>
<td>The Battery Has Reached Critically Low Power Status</td>
</tr>
<tr>
<td>📧</td>
<td>Blinking Green</td>
<td>New Mail Has Arrived</td>
</tr>
</tbody>
</table>

1 - 6 System Map: Top View with LCD Panel Open
AP-Key Buttons
These buttons power on/off the optional PC Camera and Bluetooth modules, access the internet and e-mail, and enable/disable high performance video.

Table 1 - 3 - AP-Key Buttons

<table>
<thead>
<tr>
<th>AP-Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D</td>
<td>Enable/Disable High Performance Video</td>
</tr>
<tr>
<td>🎥</td>
<td>Enable/Disable the optional PC Camera Module</td>
</tr>
<tr>
<td>📞</td>
<td>Enable/Disable the optional Bluetooth Module</td>
</tr>
<tr>
<td>📧</td>
<td>Activate the Default E-mail Program</td>
</tr>
<tr>
<td>🌐</td>
<td>Activate the Default Internet Browser</td>
</tr>
</tbody>
</table>

3D Ap-Key Button
Use this button to enable/disable high performance video when powered by the AC/DC adapter (the 3D Ap-Key button will be illuminated in blue when in high performance video mode).

If you switch from AC Power to battery power the system will automatically change to a lower performance video mode setting. **High Performance Video can not be enabled when the system is battery powered.**

The system will retain in memory the last known video performance setting if you switch back from battery to AC power.

Function Keys & Numeric Keypad
The keyboard has an embedded numerical keypad for easy numeric data input (see Figure 1 - 3 on page 1 - 8).

Activate the Number Lock feature by pressing the Num Lk key at the top right of the keyboard. You may check if Number Lock is enabled or not by looking at the LED status indicators.
**Quick Start Guide**

*Table 1 - 4 - Function Keys*

<table>
<thead>
<tr>
<th>Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn</td>
<td>Function Key</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>Touchpad Toggle</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>SRS WOW Surround Sound Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
</tr>
<tr>
<td>Fn + F5</td>
<td>Decrease Audio Volume</td>
</tr>
<tr>
<td>Fn + F6</td>
<td>Increase Audio Volume</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + F8</td>
<td>Decrease LCD Brightness</td>
</tr>
<tr>
<td>Fn + F9</td>
<td>Increase LCD Brightness</td>
</tr>
<tr>
<td>Fn + F11</td>
<td>WLAN Module Toggle</td>
</tr>
<tr>
<td>Fn + Scr Lk</td>
<td>Scroll Lock Toggle</td>
</tr>
</tbody>
</table>

*Figure 1 - 3 - Keyboard*

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However, special functions/hot keys unique to the system’s regular keyboard may not work.
1. LCD Latches
2. Consumer Infrared Transceiver*
3. 7-Pin S-Video-Out Jack
4. DVI-Out Port
5. DC-In Jack
6. Vent/Fan Intake
7. RJ-11 Phone Jack
8. 2 * USB 2.0 Ports
9. Serial Port
10. S-Video-In Jack*
11. Security Lock Slot

*Enabled with Optional Mini-PCI TV Tuner Only

Overheating

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.

7-Pin S-Video-Out Jack

The 7-pin S-Video Out Jack requires an adapter cable (7-pin S-Video plug to 4-pin S-Video jack adapter) in order to connect to a standard S-Video cable (the y-cable pictured includes a yellow composite video jack).
Quick Start Guide

System Map: Left View

Figure 1 - 5
Left View

1. S/PDIF-Out Jack
2. Line-In Jack
   (see page A - 3)
3. Microphone-In Jack
4. Headphone-Out Jack
5. Optical Device Drive Bay
   (for CD/DVD Device)

Changing DVD Regional Codes

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code (see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or similar object that may break and become lodged in the hole.

Media Warning

Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to “crash”.
System Map: Right View

1. PC Card Slot
2. Mini-IEEE 1394a Port
3. 3 * USB 2.0 Ports
4. TV Antenna Jack* (see page 2 - 12)
5. 4-in-1 Card Reader
6. Infrared Transceiver
7. RJ-45 LAN Jack

*Enabled with Optional Mini-PCI TV Tuner Only

---

4-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:
- MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro)

Mini-IEEE 1394a

The Mini-IEEE 1394a port only supports **SELF POWERED** IEEE 1394a devices.
Quick Start Guide

System Map: Bottom View

1. Battery
2. Battery Release Latch
3. CD/DVD Device Release Latch
4. Hard Disk Bay Cover
5. Vent/Fan Intake
6. Sub Woofer
7. Component Bay Cover
8. Speakers

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 9 for full instructions.
Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows XP are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu. The Control Panel allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic control panels for many of the features, however many new control panels are added (or existing ones are enhanced) when you install the drivers listed in Table 4 - 1, on page 4 - 6. To see all controls it may be necessary to toggle off Category View.
Quick Start Guide

Video Features

This computer features an NVIDIA Scalable Link Interface (SLI) that improves graphic quality and performance by combining dual NVIDIA GPUs in a single system to allow the two graphics cards to run in parallel. You can switch display devices, and configure display options, from the Display Properties control panel in Windows as long as the appropriate video driver is installed.

To access Display Properties in Windows:
1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
   (You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click Settings and adjust as above.)
4. Move the slider to the preferred setting in Screen area/resolution 1 (Figure 1 - 9 on page 1 - 15).
5. Click the arrow, and scroll to the preferred setting in Colors/Color quality 2 (Figure 1 - 9 on page 1 - 15).
6. Click Advanced (button) 3 (Figure 1 - 9 on page 1 - 15) to bring up the Advanced properties tabs.
7. Click GeForce Go ... (tab).
8. Clicking the tabs or Additional Properties allows you to make any video adjustments you require.

Display Devices & Options

Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or TV as your display device (Note: SLI Multi-GPU supports only single display mode). A VGA monitor/Flat Panel Display connects to the DVI-Out port, a TV to the S-Video-Out jack. See Table 1 - 9 on page 1 - 15 for a summary of the display modes available, and see “NVIDIA Video Driver Controls” on page B - 1 for more detailed video information.
**Display Mode** | **Description**
---|---
Single | One of the connected displays is used as the display device
Clone* | Both connected displays output the same view
Dualview* | Both connected displays are treated as separate devices, and act as a virtual desktop

*Note: SLI Multi-GPU supports only single display mode (disable SLI Multi-GPU before switching to Clone or Dualview modes).
Power Management Features

The Power Options control panel in Windows (see page 1 - 13) allows you to configure power management features for your computer. You may conserve power through individual components such as the monitor or hard disk (by means of Power Schemes), or you may use either Stand by or Hibernate mode to conserve power throughout the system (enable Hibernate support from the control panel as pictured in Figure 1 - 10). Pay attention to the instructions on battery care in “Battery Information” on page 3 - 9.

The computer’s power button, sleep button (Fn + F4 key combination), and lid (closing the lid) may be set to send the computer in to either Stand by or Hibernate mode.

Power Saving and Performance
Power Schemes may have an affect on your computer performance (see “Power Schemes” on page 3 - 4).
Chapter 2: Storage Devices, Mouse, Audio & Printer

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Optical Device
- 4-in-1 Card Reader
- PC Card Slot
- Auto Mail Checker
- TouchPad and Buttons/Mouse
- Audio Features
- Configuring the Infrared Settings for FIR
- Adding a Printer
Storage Devices, Mouse, Audio & Printer

Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5” serial (SATA II) hard disk drives with a height of 9.5 mm. The hard disk ① is accessible from the bottom of your computer as seen below. Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive(s)” on page 6 - 4.

Figure 2 - 1
Hard Disk Location
Optical Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the model you purchased (see "Storage Options" on page C-3). The optical device is usually labeled "Drive D:" and may be used as a boot device if properly set in the BIOS (see "Boot Menu" on page 5-12).

Loading Discs

To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting.

Peripherals must be connected before you turn on the system.

Figure 2 - 2
Optical Device
Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.
DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on page 1 - 10.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

Table 2 - 1
DVD Regional Coding

Figure 2 - 3
DVD Regions
4-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device.

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS Pro (Memory Stick Pro)

Card Reader Cover
Make sure you keep the cover in the card reader when not in use. This will help prevent foreign objects and/or dust getting in to the card reader.

*Figure 2 - 4
Right View

1. Card Reader
PC Card Slot

The computer is equipped with a PCMCIA 3.3V/5V slot for **one type II** PC Card.

**Inserting and Removing PC Cards**

- Align the PC Card with the slot and push it in until it locks into place.
- To remove a PC Card, simply press the eject button next to the slot.

*Figure 2 - 5
PC Card Slot*
After you have installed the driver for the Auto Mail Checker program (see “Auto-Mail Checker” on page 4-11) you may then configure it to give you notification when you receive new mail. You must be online to receive this notification (note that this program only supports the POP3 protocol), and your default mail program does not need to be open.

When the program is run, the Auto Mail Checker appears as an icon in the taskbar (to run the program go to Start > Programs/All Programs > Auto Mail Checker > Auto Mail Checker). Right clicking on the icon will bring up the following options menu. If you have not input your mail account data, then you will be prompted to do so.

Select Open to bring up the control panel for the program.
You may then configure the options for your mailserver, name, password, program and method(s) of notification.

Note
Check with your Internet Service Provider, network administrator or Mail Service provider for details on what to put on these pages.

Figure 2 - 7
Auto Mail Checker Account Setup and Options
The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse. The central button may be configured to function as you require.

Once you have installed the TouchPad driver (see page 4 - 10) you can configure the functions by double-clicking the TouchPad driver icon in the taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. The TouchPad may be toggled on/off by means of the \textbf{Fn} + \textbf{F1} key combination.

Mouse Driver
If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device's user documentation for details.

Figure 2 - 8
Mouse Properties
Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices Windows control panel (see Figure 1 - 8 on page 1 - 13), or from the Sound Manager icon in the taskbar/control panel (this will bring up the AC97 Audio Configuration menu). Adjust the volume by using the Fn + F5/F6 key combination.

The audio system features SRS WOW Surround Sound Technology inside (SRS/ TruSurround/ TruBass / Focus Enhancement). SRS WOW Surround Sound may be toggled on/off using the Fn + F2 key combination.

Note that audio input through Line-in will default to the mute setting. To set up your audio sources to play though the Line-in jack go to the Sounds and Audio Devices Windows control panel and make sure the Mute box is not ticked.

![Sound Volume Adjustment](image)

Figure 2 - 9
AC97 Audio Configuration Menus
Configuring the Infrared Settings for FIR

To configure your computer’s infrared port (on the right of the computer) for Far Infrared (FIR) communication follow these steps:

1. Click **Start**, point to **Settings** and click **Control Panel** (or just click **Start > Control Panel**).
2. Double-click **Wireless Link** (Printers and Other Hardware Category) icon.
3. Click **Hardware** (tab), and click the **Properties** button, then click the **Advanced** (tab).
4. Select “**Infrared Transceiver A**” and change the **Value** to “**HP HSDL-2300/3600**”.
5. Click **OK > OK**.
6. Restart the computer if prompted to do so.

You can enable/disable the infrared transceiver in the BIOS (see “**I/O Device Configuration (Advanced Menu)**” on page 5 - 9). For further information, please refer to the manual of the device you wish to connect.
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer, however it is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer

Most new printers have a USB interface connection. You may use any one of the ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar (you will need to purchase a parallel to USB converter).
Storage Devices, Mouse, Audio & Printer
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer uses the ACPI power management system. Power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

This chapter covers:

- The Power Sources
- Turning on the Computer
- Power Schemes
- System Power Options
- Configuring the Power Button
- Battery Information

Advanced Configuration and Power Interface

The ACPI interface provides the computer with enhanced power saving techniques and gives the operating system (OS) direct control over the power and thermal states of devices and processors. For example, it enables the OS to set devices into low-power states based on user settings and information from applications. ACPI is fully supported in Windows XP.
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components (see page C - 5).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 12).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 9.
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Shutdown

Note that you should always shut your computer down by choosing the Shut Down/Turn Off Computer command from the Start menu in Windows. This will help prevent hard disk or system problems.
Power Schemes

You can set your computer to conserve power through individual components by means of **Power Schemes**. You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter **Stand by** or **Hibernate** modes (see “System Power Options” on page 3 - 6).

**Figure 3 - 1**
Power Schemes
Each *Windows Power Scheme* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose the *Home/Office Desk* scheme for maximum performance when the computer is powered from an AC power source. Choose the *Max Battery* scheme (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.

*Windows* will use *Portable/Laptop* as the default scheme.
System Power Options

You can use the system power options to stop the computer’s operation and restart where you left off. This system features Stand by and Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking the option in the Hibernate tab in the Power Options control panel - Figure 3 - 2 on page 3 - 7).

Hibernate Mode vs. Shutdown

Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

Stand by Mode vs. Hibernate Mode

If you want to stay away from your work for just a while, you can put the system on Stand by instead of in hibernation. It takes a longer time to wake up the system from Hibernate mode than from Stand by mode.
Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full operation. During Stand by the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Stand by mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.
Configuring the Power Button

The power button may be set to send the computer into either Stand by or Hibernate mode. In Stand by mode, the LED will blink green. In Hibernate mode the LED will be off. If you are in a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

You may also configure the Sleep/Resume key combination ($\text{Fn} + \text{F4}$) from the menu illustrated in Figure 3-3. In Windows this is referred to as the Sleep button.
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 12 for instructions on how to do this).

Battery Life

Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power Meter from the Power Options control panel), and settings in the OS will help prolong the battery life if configured appropriately.

Figure 3 - 4
Power Options (Alarm & Power Meter)
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.

3D Ap-Key Button
The system will default to high performance video when powered by the AC/DC adapter (the 3D Ap-Key button will be illuminated in blue). If you switch from AC power to battery power the system will automatically change to a lower performance video mode setting in order to save power. High Performance Video can not be enabled when the system is battery powered (see “3D Ap-Key Button” on page 1 - 7).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 6 for information on the battery charge status, and to “Battery Information” on page 3 - 9 for more information on how to maintain and properly recharge the battery pack.)
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own. Disable the **Power Options** functions in the **Control Panel**, especially any **Alarms** (unclick the tickboxes - see 3 - 9) and **Schemes** (change all the settings to **Never** - see page 3 - 4). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities. The following operating system is covered.

• *Windows XP Professional and Home Editions (with Service Pack 2)*

What to Install

The *Device Drivers & Utilities + User’s Manual CD-ROM* contains the drivers and utilities necessary for the proper operation of the computer. The drivers for all the modules (*WLAN*, *Bluetooth*, *PC Camera* and *TV Tuner*) are on the separate *CD-ROMs* supplied. Table 4 - 1 on page 4 - 6 lists what you need to install manually according to your choice of the operating system, and it is very important that the drivers are installed in the order indicated.

Module Driver Installation

The procedures for installing drivers for the *Wireless LAN*, *Bluetooth*, *TV Tuner*, and *PC Camera* modules are provided in “Modules” on page 7 - 1. Make sure that the drivers are installed in the order indicated in Table 4 - 1 on page 4 - 6.
Navigate (Browse..) to D:

You will notice that many of the instructions for driver installation require you to "Navigate (Browse) to D:“. We assume that you will install all drivers and utilities from the built-in CD device and it is assigned to “Drive D:“. In addition, all file extensions can be seen in this case “D:” is the drive specified for your CD device. Not all computers are setup the same way, and some computers have the CD listed under a different drive letter - e.g. if you have two hard drives (or hard disk partitions) one may be designated as “Drive C:“ and the other as “Drive D:“. In this case the CD device may be designated as “Drive E:“ - Please make sure you are actually navigating to the correct drive letter for the CD device.

When you click the Browse (button) after clicking Run in the Start menu you will see the “Look in:“ dialog box at the top of the Browse window. Click the scroll button to navigate to My Computer to display the devices and drive letters.

4 - 2 What to Install
Service Packs
Check the warnings on the following pages regarding installation of the appropriate Service Pack for your Windows OS. If you are unsure of the Service Pack currently installed see below. Make sure you have installed the appropriate Service Pack before installing all the drivers.

Service Pack Installed
To see which Service Pack is currently installed on your computer go to the General tab of the System control panel. Right-click the My Computer icon on the desktop or in the Start menu and select Properties. The Service Pack currently installed on your system will be listed under the “System:” heading. (If no Service Pack information is listed, then no Service Pack is installed.)

Windows XP Service Pack 2
Make sure you install Windows XP Service Pack 2 (or a Windows XP version which includes Service Pack 2) before installing any drivers. Service Pack 2 includes support for USB 2.0.
If you have upgraded the system by installing Service Pack 2 (i.e. your Windows XP version does not include Service Pack 2) then follow these instructions:
1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click the Hardware (tab) > Device Manager (button).
4. Click “+” next to Other Devices (if its sub-items are not shown).
5. Right-click Universal Serial Bus (USB) Controller and select Uninstall > OK (if you don’t see the item then there is no need to take any further action).
6. Restart the computer and it will find the USB 2.0 controller.
Drivers & Utilities

Authorized Driver Message
If you receive a message telling you that the driver you are installing is not authorized (Digital Signature Not Found), just click Yes or Continue Anyway to ignore the message and continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

Version Conflict Message
During driver installation if you encounter any “file version conflict” message, please click Yes to choose to keep the existing (newer) version.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Add/Remove Programs item. If you see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the Add/Remove Programs item:
1. Click Start (menu), point to Settings and click Control Panel (or click Start > Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.
Driver Installation

Insert the Device Drivers & Utilities + User’s Manual CD-ROM and the Notebook Driver Installation application will run automatically. If you want to install the driver manually see Page 4 - 6.

1. Check the driver installation order from Table 4 - 1 on page 4 - 6 (the drivers must be installed in this order) which is the same as that listed in the driver installation screen menu.
2. Double-click to select the name of the driver you wish to install.
3. Follow the instructions as listed in this chapter.
4. Make a note of the drivers you have installed.
5. If a restart is required after installing a driver, you will usually need to click the “Yes/Finish” button when prompted to restart the computer.
6. To get back to the Notebook Driver Installation screen click Start (menu) > Run... and navigate (Browse..) to D:\setup.exe and click OK.
   OR
   Double-click the My Computer icon, and then double-click the CD icon.
Drivers & Utilities

Table 4 - 1 - Driver Installation

Manual Driver Installation
If you wish to install the drivers manually, click the Exit button to quit the Notebook Driver Installation application, and then follow the manual installation procedure for each driver. The manual installation procedure begins with instructions on how to browse to the executable file; “Click Start (menu) > Run.”
Windows XP

Driver Installation Procedure
This section covers driver and utility installation instructions for Windows XP Home & Professional. Insert the Device Drivers & Utilities + User’s Manual CD-ROM and click the appropriate driver name from the Notebook Driver Installation menu and follow the instructions to install the driver, or Click Start and navigate (Browse..) to follow the manual setup instructions.

New Hardware Found
If you see the message “New Hardware Found” (Found New Hardware Wizard) during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.

Chipset
1. Double-click Chipset.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\00CHIPSET\setup.exe and click OK.
2. Click Next > Next > Next > Yes.
3. Click Finish to restart the computer.

Video (VGA)
1. Double-click VGA.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\01VGA\setup.exe and click OK.
2. Click Next (click Continue Anyway if asked if you want to continue at any time).
3. Click Finish to restart the computer.
Drivers & Utilities

Audio
1. Double-click **Audio**.
OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to **D:\Drivers\02AUDIO\setup.exe** and click **OK**.
2. Click **Next**.
3. Click **Finish** to restart the computer.

Modem
1. Double-click **Modem**.
OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to **D:\Drivers\03MODEM\Setup.exe** and click **OK**.
2. Click **OK > OK**.
3. The modem is now ready for configuration.

*Modem Country Selection*

Be sure to check if the modem country selection is appropriate for you (**Control Panel > Phone and Modem Options**).
**LAN**

1. Double-click **Lan**.
   OR
   Click **Start** (menu) > **Run...** and navigate (**Browse..**) to **D:\Drivers\04LAN\SetupYukonWin.exe** and click **OK**.
2. Click **Next**.
3. Click the button to accept the license and click **Next**.
4. Click **Install > Finish**.
5. The network settings can now be configured.

**AP-Key Buttons**

1. Double-click **AP-key**.
   OR
   Click **Start** (menu) > **Run...** and navigate (**Browse..**) to **D:\Drivers\05AP-Key\AKSETUP.exe** and click **OK**.
2. Click **Next**.
3. Click **Finish** to restart your computer.
Drivers & Utilities

TouchPad
1. Double-click **Touchpad**.
   OR
   Click **Start** (menu) > **Run...** and navigate (Browse...) to D:\Drivers\06TOUCHPAD\setup.exe and click **OK**.
2. Click **Next** > **Next** (click **Continue Anyway** if asked if you want to continue at any time).
3. Click **Finish** to restart your computer.
4. You may then configure your TouchPad as outlined in “**TouchPad and Buttons/Mouse**” on page 2 - 10.

PCMCIA
1. Double-click **PCMCIA**.
   OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to D:\Drivers\07PCMCIA\setup.exe and click **OK**.
2. Click **Next**.
3. Click **Finish**.

AMD Processor
1. Double-click **AMD**.
   OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to D:\Drivers\08AMD\setup.EXE and click **OK**.
2. Click **Next** > **Yes** > **Next** > **Next**.
3. Click the button “**Yes, I want to restart the computer now.**”, and click **Finish** to restart the computer.
AutoMail Checker
1. Double-click AUTOMAIL.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\09AUTOMAIL\SETUP.EXE and click OK.
2. To continue click Next > Next > Finish.
3. Run the program from the Auto Mail Checker in the Start menu (Start > Programs/All Programs > Auto Mail Checker).
4. Click the icon in the taskbar to input the e-mail account details.
5. For further details see “Auto Mail Checker” on page 2 - 8.

Module Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option.

PC Camera
See the install procedure in “PC Camera Module” on page 7 - 2.

Wireless LAN
See the appropriate install procedure for your WLAN module in either “Intel WLAN Driver Installation” on page 7 - 9, or “MSI 6833B WLAN Driver Installation” on page 7 - 10.

Bluetooth
See the install procedure in “Bluetooth Driver Installation” on page 7 - 12.

TV Tuner
See the install procedure for your TV Tuner module in “Installing the AverTV Utility Software” on page 7 - 15.
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you are doing. Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

Warning
Incorrect settings can cause your system to malfunction. To correct mistakes, return to Setup and restore the Setup Defaults with <F9>.
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

- Press <F1> to resume
- <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt (Press F2 to Enter Setup) seen in Figure 5 - 1 on page 5 - 2 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 when prompted. The Setup main menu will appear.
Setup Screens

The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with five (5) menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ➤ next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
### System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
Primary Master/SATA Port 4 (Main Menu)
Pressing **Enter** here opens the sub-menu to show the configuration of hard disks and CD/DVD device(s) on the computer’s IDE Channels. Use the **Auto** (Type:) setting to have the items configured automatically for you.

System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.

The **Main** menu also contains information on your video card and video BIOS version.
Advanced Menu

**Advanced Chipset Control (Advanced Menu)**
Pressing **Enter** here will access the sub-menu which allows you to disable the audio and modem devices if required.
I/O Device Configuration (Advanced Menu)
The sub-menus under this item allow you to enable/disable the **Serial port A (Serial Mouse)**, and **FIR (Infrared) transceiver**.

**Reset Configuration Data (Advanced Menu)**
This item is set to **No** as default. You can change the setting to **Yes** if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.

**Power On Boot Beep (Advanced Menu)**
Use this menu to enable/disable the single beep sound at the end of the POST. This item is “**Disabled**” by default.

**Battery Low Alarm Beep: (Advanced Menu)**
Use this menu item to enable/disable the battery low alarm beep.
Set Supervisor Password (Security Menu)

You can set a password for access to the Setup utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a Password on Boot (see over).
Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer. If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.
When you turn the computer on it will look for an operating system (e.g. Windows XP) from the devices listed in this menu, and in this priority order. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the Boot priority order. Item specific help on the right is available to help you move devices up and down the order.
Exit Menu

Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

- A small crosshead or Phillips screwdriver
- A small regular slotted (flathead) screwdriver
- An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

- Removing the Battery
- Upgrading the Hard Disk Drive(s)
- Upgrading the System Memory (RAM)
- Upgrading the Optical (CD/DVD) Device(s)
- Removing the Video Card(s)

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.
When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts. You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.

---

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

**Removal Warning**

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

1. Turn the computer off, turn it over and remove the battery.
2. Slide latch 1 towards the unlock symbol and hold it in place, and slide latch 2 in the direction of the arrow.
3. Slide the battery 3 out and lift it up and out of the battery bay.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 1
Battery Removal
Upgrading the Hard Disk Drive(s)

The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA II) hard disk drives with a height of 9.5mm (h) (see “Storage Options” on page C - 3). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws 1 - 3.
3. Remove the bay cover 4.

---

HDD System Warning

New HDD’s are blank. Before you begin make sure:
- You have backed up any data you want to keep from your old HDD.
- You have all the CD-ROMs and FDDs required to install your operating system and programs.
- If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.

---

Figure 6 - 2
HDD Bay Cover Removal
4. Slide the hard disk assembly in the direction of the arrow 5.
5. Remove the hard disk assembly 6.
6. Remove screws 7 - 10 and separate the bracket 11 from the hard disk 12.
7. Reverse the process to install a new hard disk(s).
Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-DIMM) DDR type memory modules (see “Memory” on page C - 2). The total memory size is automatically detected by the POST routine once you turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws 1 - 13.

*Figure 6 - 4*
Bay Cover Screws
Upgrading The Computer

3. Remove the bay cover 14.

4. Gently pull the two release latches (15 & 16) on the sides of the memory socket in the direction indicated by the arrows in Figure 6 - 6.

Contact Warning
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.

Figure 6 - 5
Bay Cover Removal

Figure 6 - 6
RAM Module Release
Upgrading The Computer

6 - 8 Upgrading the System Memory (RAM)

5. The RAM module will pop-up, and you can remove it.

6. Pull the latches to release the second module if necessary.

7. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory socket.

8. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the socket as it will go. DO NOT FORCE the module; it should fit without much pressure.

9. Press the module in and down towards the mainboard until the socket levers click into place to secure the module.

10. Replace the cover and screws (see Figure 6 - 4).

11. Restart the computer to allow the BIOS will register the new memory configuration as it starts up.

Figure 6 - 7
RAM Removal
Upgrading the Optical (CD/DVD) Device(s)

1. Turn the computer off, turn it over and remove the battery.
2. Slide the latch towards the unlock symbol and hold it in place.
3. Slide the optical device out of the computer at point 2.
Removing the Video Card(s)

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws 1 - 13.
3. Remove the bay cover 14.
Upgrading The Computer

4. Remove screws (15 & 18).
5. Carefully (a cable is still connected) grip the plastic tag and lift the video card up.
6. Disconnect cable 19, and lift the video card off the computer.

**Caution**
The heat sink, and video card area in general, contains parts which are subject to high temperatures. Allow the area time to cool before removing these parts.

*Figure 6 - 10*
Video Card Removal
Upgrading The Computer
Chapter 7: Modules

Overview

This chapter contains the information on the various modules (some of which are optional) which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

- PC Camera Module
- Mini-PCI Wireless LAN Module
- Bluetooth Module
- Mini-PCI TV Tuner Module
If your purchase includes the optional PC Camera you will need to install the device driver for it as indicated on the following pages (make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 6).

**PC Camera Driver Installation**

1. Insert the **PC Camera CD-ROM** into the CD/DVD Drive.
2. The program will run automatically.
3. Click Next (click Continue Anyway if asked if you want to continue at any time).
4. Click Finish > OK to restart the computer.
5. Use the Ap-Key button \[ \text{ } \] to turn the PC Camera module on (the \[ \text{ } \] LED will be green).
6. Run the emAMCAP application software from the **USB2.0 1.3M PC CAM** item in the Start > Programs/All Programs menu (give the computer time to find the hardware).

**Latest PC Camera Driver Information**

Check the PC Camera CD, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.
PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Go to the Start menu and point to Settings (or click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in Device volume (Volume tab).
3. Click Options and scroll down and click Properties.
4. Select Realtek AC97 Audio from the Mixer Device menu.
5. Click Recording (button).
6. Click Microphone (check box) if it is not checked, and then click OK.
7. Make sure the Select (check box) in the Recording Control panel, under the Microphone section, is checked (boost the volume as high as it will go).
8. Close the window, and then click OK.

---

Taking Still Pictures

You may take still pictures in the Windows XP operating system only.

Double-click the My Computer icon on the desktop, or go the Start menu and point to My Computer, then click it.

Double-click the USB2.0 1.3M PC CAM icon.

Click Take a new picture in the Camera Tasks box.
Figure 7 - 1
Audio Setup
EMAMCAP
The EMAMCAP video viewer can capture video files to .avi format, and is useful for basic general purpose video viewing and testing (a number of commercially available programs support advanced video capture features).

1. Run the EMAMCAP program from the Start > Programs/All Programs > USB2.0 1.3 PC Cam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading and select Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name, size (see the sidebar - Pre-Allocating File Space) and location for the captured file.
4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video..., choose a file name and location, and then click Open (you can view the file using the Windows Media Player).

Set Capture File
In the EMAMCAP program you will only be asked to set the capture file name on the first run of the program. When you run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files you can go to the Set Capture File.. option in the File menu, and set the file name and location before capture. Set the name and location then click Open (you can choose Cancel to ignore the file size if prompted).

Pre-Allocating File Space
You may pre-allocate the file size for the capture file in the EMAMCAP program. You can choose to ignore this by clicking Cancel.

Pre-allocating space on the hard disk can improve the capture quality (particularly of large capture files), by reducing the amount of work the hard disk has to do in finding space for the video data as it is being captured.

You may find it helpful to defragment the HDD before capture.
Eliminating Screen Flicker
If you find that the video screen in the EMAMCAP program is flickering, you can try to adjust the setting in the Lighting Selection options.

1. Run the EMAMCAP program.
2. Go to Options and scroll down to select "Video Capture Filter...".
3. Click Video Image (tab).
4. Select Florescent 50Hz, Florescent 60Hz or Incandescent in the Light dropdown.
The Wireless LAN & Bluetooth Modules

If your purchase option includes a Wireless LAN and/or Bluetooth module, follow the information on the following pages for instructions on installing the driver(s). Pay careful attention to the warnings concerning the use of wireless modules aboard aircraft, and the instructions on enabling/disabling power to the module(s).

Power Toggle for the Wireless LAN and Bluetooth Modules

You will need to enable power to the modules by using the following key combinations:

Fn + F11 = Wireless LAN Module Power Toggle
Bluetooth Ap-key  = Bluetooth Module Power Toggle

When the Wireless LAN module is powered on, the LED will be green.

When the Bluetooth module is powered on, the LED will be green.

Do not try to use the Wireless LAN module and the Bluetooth module at the same time, as this may cause a communication conflict.
Mini-PCI Wireless LAN Module

Before installing the Wireless LAN driver, make sure that the WLAN module is on (the LED will be green).

Use the WLAN module key combination **Fn + F11** to toggle power to the WLAN module. Make sure you install the drivers in the order indicated in *Table 4 - 1, on page 4 - 6*.

You may have **one** of two (Intel or MSI) optional Mini-PCI Wireless LAN modules supplied with your computer; depending on your purchase configuration. You will be provided with the appropriate driver CD for your module. Insert the CD and follow the installation procedure.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are **OFF** if you are using the computer aboard aircraft.
Intel WLAN Driver Installation

1. Make sure the module is powered on, and then insert the Intel PROSet/Wireless CD-ROM into the CD/DVD drive.
2. Click **Install Software** (button).
3. Click the button to accept the license and click **Next > Next > OK**.
4. Click **OK** to complete the installation.
5. You can configure the settings by going to the Intel (R) PROSet Wireless control panel (**Start > Programs/All Programs > Intel PROSet Wireless**), or by double-clicking the taskbar icon 📀.
Module

MSI 6833B WLAN Driver Installation

1. Make sure the WLAN module is powered ON.
2. Insert the Wireless LAN CD-ROM into the CD/DVD drive.
3. The program will run automatically.
4. Click Install Software (button).
5. Click Yes to accept the license agreement.
6. Click Next > Next.
7. Click Finish to restart the computer.
8. The network settings can now be configured.
9. Double-click the WLAN icon in the taskbar to run the RaLink Wireless Utility (right-click the icon to bring up the utility menu).
10. Click Rescan to scan for available access points.
11. Select an access point and click Connect to start the access process (e.g. Authentication and Security).
12. You can access the RaLink Wireless Utility from the Start menu (Start menu and point to Programs/All Programs > RaLink Wireless).

To view the Help menu, click About (tab) in the RaLink Wireless Utility. Click Help (button) to bring up the menu, and click Contents to access the links to help contents.
WLAN Icon

The WLAN icon will change color to reflect the network connection status:

- Signal Strength is Good
- Signal Strength is Normal
- Signal Strength is Weak
- Not Connected Yet
- Wireless Module Not Detected

Figure 7-4: WLAN Utility
Bluetooth Module

Before installing the Bluetooth driver, make sure that the optional Bluetooth module is on (the LED will be green). Use the Ap-key to toggle power to the Bluetooth module. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 6.

Bluetooth Driver Installation

1. Make sure the module is powered on, and then insert the Bluetooth CD-ROM into the CD/DVD drive.
2. The program will run automatically.
3. Choose the language you prefer, and click OK.
4. Click Next.
5. Click the button to accept the license agreement, and then click Next.
6. Click Next > Next > Install.
7. Click Finish > Yes to restart the computer.
8. The IVT Corporation BlueSoleil - Main Window screen appears on restart.
9. You can configure the settings at any time by going to the IVT Corporation BlueSoleil - Main Window control panel (Start > Programs/All Programs > IVT BlueSoleil), or by clicking the taskbar icon.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.
View the BlueSoleil User Guides from the Help Menu (or press the F1 key) in the IVT Corporation BlueSoleil - Main Window control panel. Click BlueSoleil User Guides in the Contents tab, and click to select the appropriate User Guide from the panel on the right.
Mini-PCI TV Tuner Module

You may have one of two optional Mini-PCI TV Tuner modules supplied with your computer, depending on your purchase configuration. The optional TV Tuner allows you to watch TV, play music CDs, video conference and capture still images and video on your PC.

The AverMedia M103 Hybrid (for both analog and digital inputs) or AverMedia M102 (for analog input only) Mini-PCI TV Tuner Module comes with a remote control unit and CDs containing the AverTV Utility software & Power DVD software.

The TV antenna jack and S-Video-In jack will only be enabled when the TV Tuner module is installed. Make sure you install any software before connecting the TV antenna.

Figure 7-6
TV Tuner Ports
1. Consumer IR Transceiver
2. S-Video-In Jack
3. TV Antenna Jack
AverMedia Mini-PCI TV Tuner Module

If your purchase includes either of the AverMedia Mini-PCI TV Tuners, then install the driver and software as per the instructions below.

Installing the AverTV Utility Software
1. Insert the AverTV Utility CD-ROM into the CD/DVD drive.
2. Click TV Utility Software.
3. Click Yes > Next > Next (click Continue Anyway if asked to continue at any time).
4. Click Finish.
5. Run the program from the Start > Programs/All Programs > AVer TV menu, and select the AVer TV program, or double-click the icon on the desktop.

Installing the Cyberlink Power DVD Software
1. Insert the Cyberlink PowerDVD CD-ROM into the CD/DVD drive.
2. Click Next > Yes > Next >.... Next.
3. Click Finish.
4. Run the program from the Start > Programs/All Programs > CyberLink PowerDVD menu, and select the CyberLink PowerDVD program, or double-click the icon on the desktop.
5. Type in the serial number and click Activate, then run the software again.
6. See over for instructions on configuring S/PDIF audio output.

User Manual
Insert the TV Tuner CD-ROM and double-click Acrobat Reader (button) and follow the instructions to install the program (if you have not already done so). Double-click User Manual from the menu to access the manual.

TV Antenna
The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.
Digital TV Broadcast Signal

The antenna is the most crucial factor in receiving a clear Digital Terrestrial TV broadcast signal. The passive antenna provided should provide a clear signal when placed beside a window. If the signal is not clear then you can purchase an active antenna (it should also be placed beside a window) to improve the signal. You should also check with any related government website which provides information on Digital Terrestrial TV coverage for your area. Note that (unlike standard analog TV) if the digital signal is weak then no picture will appear on the TV at all.

Setting S/PDIF for Audio Output in Cyberlink Power DVD

If you want to use the S/PDIF-Out jack for audio output in the Cyberlink Power DVD application, then you should configure the application as follows:

1. Connect the speakers to the S/PDIF-Out Jack.
2. Run the Power DVD application.
3. Right-click the screen, then scroll down and select the Configuration menu item.
4. Click Audio (tab).
5. Select SPDIF from the Speaker Environment menu.
6. Click OK.
7. The system is now set up to play the sound through the S/PDIF-Out Jack, however note that audio output will only be played through the external speakers, and not the system speakers.
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a **power strip**, make sure it is actually working. Check the **LED Power Indicators** (see “LED Indicators” on page 1 - 6) to see the computer’s power status.

- **Connections** - Check all the **cables** to make sure that there are no **loose connections** anywhere.

- **Power Savings** - Make sure that the system is not in **Hibernate** or **Stand by** mode by pressing the keys configured in your *Power Management/Power Options* (see “Configuring the Power Button” on page 3 - 8), the **Fn + F4** key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the **Fn + F8 and F9** keys to adjust the brightness (see *Table 1 - 4, on page 1 - 8*).

- **Display Choice** - Press **Fn + F7** to make sure the system is not set to “external only” display (see *Table 1 - 4, on page 1 - 8*).

- **Boot Drive** - Make sure there are no **floppy disks** in any connected drive when you start up your machine (this is a common cause of the message “**Invalid system disk - Replace the disk, and then press any key**” / “**Remove disks or other media. Press any key to restart**”).
Backup and General Maintenance

- Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

- Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Boot** password for the SCU (see “Security Menu” on page 5 - 10).

- Keep copies of vital **settings files** such as network, dialup settings, mail settings etc. (even if just brief notes).

---

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
**Troubleshooting**

**Viruses**

- Install an **Anti-Virus** program and keep the **definitions file** (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. **Anti-Virus** programs are commercially available and the **definitions file updates** are usually downloadable directly from the internet.

- Be careful when opening e-mail from sources you don’t know. **Viruses** are often triggered from within **e-mail attachments** so take care when opening any attached file. You can configure most **Anti-Virus** programs to check all **e-mail attachments**. **Note**: You should also beware of files from people you know as the virus may have infected an **address book** and been automatically forwarded without the person’s knowledge.

- Keep a “**Boot Floppy Disk**” or “**Bootable CD-ROM**” (this disk provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many **Anti-Virus** programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).

• Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.
Troubleshooting

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
# Troubleshooting

## Problems & Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned the <strong>power on</strong> but it doesn’t work.</td>
<td><strong>Battery missing / incorrectly installed.</strong> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The <strong>Battery LED power indicator</strong> , is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the AC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing <strong>battery power</strong> too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a Power Options scheme (see “Power Schemes” on page 3 - 4) check its settings. You may also be using a PC Card device that is drawing a lot of power.</td>
</tr>
</tbody>
</table>
| Actual **battery operating time** is shorter than expected. | **The battery has not been fully discharged before being recharged.** Make sure the battery is fully discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 9).  
**Power Options have been disabled.** Go to the Control Panel in Windows and re-enable the options.  
A peripheral device or PC Card is consuming a lot of power. Turn off the unused device to save power. |
Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>computer feels too hot.</strong></td>
<td>Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 9). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan intakes to be blocked.</td>
</tr>
<tr>
<td><strong>Nothing appears on screen.</strong></td>
<td>The system is in a power saving mode. Toggle the sleep/resume key combination, Fn + F4 (see “Sleep Button” on page 3 - 8). The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key combinations (see Table 1 - 4, on page 1 - 8). If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls. The computer is set for a different display. Toggle the screen display key Fn + F7 combination (see Table 1 - 4, on page 1 - 8). If an external monitor is connected, turn it on. The screen saver is activated. Press any key or touch the TouchPad.</td>
</tr>
<tr>
<td><strong>No image appears on the external monitor I have plugged in and powered on.</strong></td>
<td>You haven’t installed the video driver and configured it appropriately from the Control Panel. See “NVIDIA Video Driver Controls” on page B - 1 for instructions on installing and configuring the video driver.</td>
</tr>
</tbody>
</table>

8 - 8 Problems & Possible Solutions
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the <strong>boot password</strong>.</td>
<td><em>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</em></td>
</tr>
<tr>
<td>The <strong>sound</strong> cannot be heard or the volume is very low.</td>
<td><em>The volume might be set too low. Check the volume control in the Volume Control Panel in the Windows taskbar, or use the key combination Fn + F5 and F6 (see “Audio Features” on page 2 - 11) to adjust.</em></td>
</tr>
<tr>
<td>The <strong>compact disc</strong> cannot be read.</td>
<td><em>The compact disc is dirty. Clean it with a CD-ROM cleaner kit.</em></td>
</tr>
<tr>
<td>The <strong>compact disc tray</strong> will not open when there is a disc in the tray.</td>
<td><em>The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject hole (see “Loading Discs” on page 2 - 3).</em></td>
</tr>
<tr>
<td>The <strong>DVD regional codes</strong> can no longer be changed.</td>
<td><em>The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.</em></td>
</tr>
</tbody>
</table>

---

**Password Warning**

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>TouchPad</strong> doesn’t work.</td>
<td><em>The Touchpad has been disabled.</em> Press the Touchpad toggle (F&lt;sub&gt;n&lt;/sub&gt; + F&lt;sub&gt;1&lt;/sub&gt;) key combination (make sure you have installed the Touchpad driver).</td>
</tr>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td><em>The system’s power saving features have timed-out.</em> Use the AC/DC adapter, press a key on the keyboard, or press the sleep (F&lt;sub&gt;n&lt;/sub&gt; + F&lt;sub&gt;4&lt;/sub&gt;) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a power saving mode.</td>
<td>Power Options features are not enabled. Go to the Windows Power Options menu and enable the features you prefer (see “System Power Options” on page 3 - 6). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
<tr>
<td>The <strong>Wireless LAN/Bluetooth/PC Camera</strong> modules cannot be detected.</td>
<td><em>The modules are off.</em> Check the appropriate LED indicator (ające) to see if the modules are on or off (see “LED Indicators” on page 1 - 6). If the LED indicator is off, then press the appropriate AP-Key button/function key combination in order to enable the modules (see Table 1 - 3, on page 1 - 7/Table 1 - 4, on page 1 - 8).</td>
</tr>
<tr>
<td>The <strong>Wireless LAN/Bluetooth/PC Camera</strong> modules cannot be configured.</td>
<td><em>The driver(s) for the module(s) have not been installed.</em> Make sure you have installed the driver for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate module).</td>
</tr>
<tr>
<td>The <strong>PC Camera software</strong> displays a black screen when the <strong>EMAMCAP</strong> software is run.</td>
<td><em>The software is using the incorrect device.</em> If you have both the optional PC Camera and TV Tuner modules present, make sure you install the TV Tuner driver and application first. After installing the PC Camera driver you will need to select which device to use with the EMAMCAP program. Go to the Devices menu in the EMAMCAP program and select the <strong>USB2.0 1.3M PC CAM</strong> device (see “PC Camera &amp; TV Tuner” on page 7 - 2).</td>
</tr>
</tbody>
</table>

---

**8 - 10 Problems & Possible Solutions**
Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to communicate with external devices, connect to the internet etc.
## Interface (Ports & Jacks)

### Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Built-In Microphone</td>
<td>The built-in microphone allows you to record on your computer</td>
</tr>
</tbody>
</table>
| Card Reader                  | The card reader allows you to use the following digital storage cards:  
                                | MMC (MultiMedia Card)  
                                | SD (Secure Digital)  
                                | MS (Memory Stick)  
                                | MS Pro (Memory Stick Pro) |
| Consumer Infrared Transceiver| The **consumer infrared** transceiver at the **front** of the computer allows the computer to communicate with the remote control unit supplied with the **optional** Mini-PCI TV Tuner (see “System Map: Front & Rear Views” on page 1 - 9). |
| DC-In Jack                   | Plug the supplied AC/DC adapter into this jack to power your computer.                                                                   |
| DVI-Out Port                 | The DVI-Out (Digital Visual Interface) Port allows you to connect an external monitor, or Flat Panel Display, to allow dual video or simultaneous display on the LCD and external monitor/FPD (see “Display Devices & Options” on page 1 - 14). If you are using an older type of monitor you will need to use a converter to convert the signal from DVI to VGA. |
### Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headphone-Out Jack</td>
<td>Headphones or speakers may be connected through this jack. <strong>Note:</strong> Set your system's volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Infrared (FIR) Transceiver</td>
<td>The <strong>FIR</strong> (far infrared) transceiver on the <strong>right</strong> of the computer allows the computer to communicate with similarly equipped devices (see “Configuring the Infrared Settings for FIR” on page 2 - 12).</td>
</tr>
<tr>
<td>Line-In Jack</td>
<td>The Line-In jack allows you to play audio sources through the computer’s speakers. Note that audio input through Line-in will default to the <strong>mute</strong> setting. To set up your audio sources to play through the Line-in jack go to the <strong>Sounds and Audio Devices</strong> Windows control panel and make sure the Mute box is not ticked.</td>
</tr>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
<tr>
<td><strong>IEEE 1394</strong></td>
<td>This allows high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras (see note below).</td>
</tr>
</tbody>
</table>

**Note:**

- **IEEE 1394**
  - The Mini-IEEE 1394a ports only support **SELF POWERED** IEEE 1394 devices.
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| RJ-11 Phone Jack            | This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection.  
**Note**: Broadband (e.g. ADSL) modems usually connect to the LAN port.                                                                                                                                                                                                                                                                                                                                                                                                  |
| RJ-45 LAN Jack              | This port supports LAN (Network) functions.  
**Note**: Broadband (e.g. ADSL) modems usually connect to the LAN port.                                                                                                                                                                                                                                                                                                                                                                                                                                                                    |
| S/PDIF-Out Jack             | This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.                                                                                                                                                                                                                                                                                                                                                                             |
| Security Lock Slot          | To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.                                                                                                                                                                                                                                                                                                                                                                                                                     |
| Serial Port                 | Connect a serial type mouse to this port.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                   |
| S-Video-In Jack             | The S-Video-In jack allows video input to the computer if you have included the optional Mini-PCI TV Tuner in your purchase.                                                                                                                                                                                                                                                                                                                                                                                                                   |
| 7-Pin S-Video-Out Jack      | Connect your television to your computer and view DVDs, VCDs or anything else your computer can display. You will need a 7-pin S-Video plug to 4-pin S-Video jack adapter and S-Video cable to make the connection (see “7-Pin S-Video-Out Jack” on page 1 - 9).                                                                                                                                                                                                                                                                                                         |
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TV Antenna Jack</td>
<td>Use this jack to connect the TV antenna if you have included the <strong>optional</strong> Mini-PCI TV Tuner in your purchase.</td>
</tr>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
Appendix B: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 14.

NVIDIA Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 6.

1. Double-click VGA.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\01VGA\setup.exe and click OK.
2. Click Next (click Continue Anyway if asked if you want to continue at any time).
3. Click Finish to restart the computer.

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.
NVIDIA Video Driver Controls

3D Ap-Key Button

The system will default to high performance video when powered by the AC/DC adapter (the 3D Ap-Key button will be illuminated in blue when in high performance video mode).

If you switch from AC power to battery power the system will automatically change to a lower performance video mode setting (the 3D Ap-Key button will no longer be illuminated in blue). **High Performance Video can not be enabled when the system is battery powered.**

*Figure B - 1*

3D Ap-Key Button

1. 3D Ap-Key Button

The system will retain in memory the last known video performance setting if you switch back from battery to AC power.
NVIDIA Display Properties

More advanced video configuration options are provided in the NVIDIA Display Properties control panel tab.

1. Open the Display Properties (see page 1 - 14) control panel.
2. Click Advanced (button).
3. Click GeForce Go.... (tab).
4. Click Additional Properties (or click the icon ) to make any video adjustments.

**Taskbar Icon**

Click the NVIDIA taskbar icon then click NVIDIA Display > Laptop Display to bring up the GeForce Go... control panel.

If you cannot see the tray icon, go to the GeForce Go... control panel tab and select the Tools item from the Additional Properties menu. Click the tickbox “Enable taskbar icon”, and apply the settings.

**GeForce Go... Control Panel**

To access the GeForce Go... control panel from the desktop; right-click the desktop, then point to NVIDIA Display and click Laptop Display.
**Additional Properties**

The items listed in the **Additional Properties** window allow you to configure your display(s). If the items do not display you can either click the **Additional Properties** button, or click the icon.

**Figure B - 3**

**Additional Properties**

Click pin icon to push pin in to keep the menu open.

Some screen examples are shown on the following page.
You may make changes to the Display Settings, Color Correction, Video Overlay, Resolutions, Refresh Rates and Screen Rotation by clicking the appropriate tab and adjusting the setting.

Right-click on a control panel item to bring up a Help menu (see sidebar).

**Help Menus**

Right-click on many of the items in the tabs to bring up the “What’s This?” button.

Click the “What’s This?” button to bring up the help menu.

*Figure B - 4  
Screen Examples*
The **nView Desktop Manager** allows quick access to control panels for features such as Desktop Management, Profiles, Hot Keys etc. The Control panel may be accessed as follows.

1. Click **Start**, point to **Settings** and click **Control Panel** (or just click **Control Panel**).
2. Double-click **NVIDIA nView Desktop Manager** (icon) - Click "Switch to Classic View" from the left of the menu if you are in **Category View**.

   You can view the nView Desktop Manager control panels from the Additional Properties window.

Select **Additional Properties** from the **GeForce Go** control panel. Click the **Desktop Management** menu item and click the **Enable** button to display the options.

The **Display Wizard** helps you to quickly configure any attached displays after enabling nView Desktop Manager.

**Figure B - 5**
Desktop Manager Control Panel
Additional configuration controls and tools are available from the nView Desktop Manager.

Click the taskbar icon to bring up the menu.
Multi-GPU Display Mode Support
SLI Multi-GPU supports only single display mode (disable SLI Multi-GPU before switching to Clone or Dualview modes).

SLI Multi GPU
This computer features an NVIDIA Scalable Link Interface (SLI) that improves graphic quality and performance by combining dual NVIDIA GPUs in a single system. SLI Multi GPU needs to be enabled/disabled from the SLI multi-GPU menu item.
1. Go to Additional Properties in the GeForce Go... control panel tab (see page B - 3).
2. Select SLI multi-GPU.
3. Click the box to enable/disable SLI multi-GPU and click Apply or OK.

Figure B - 7
SLI multi-GPU Control Panel
Display Devices

Besides the built-in LCD, you can also use an external monitor/flat panel display or TV as your display device. The following are the display options:

1. The built-in LCD.
2. An external monitor connected to the DVI-Out Port (may require DVI to VGA converter).
3. A flat panel display connected to the DVI-Out Port (may require DVI to VGA converter).
4. A TV connected to the S-Video-Out jack.

Display Wizard

Use the Display Wizard in the Desktop Management window to quickly setup and configure any attached displays (see Figure B - B - 5 on page B - 6).

Multi-GPU Display Mode Support

SLI Multi-GPU supports only single display mode (disable SLI Multi-GPU before switching to Clone or Dualview modes).

Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aerial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tuner first, then the monitor.
Attaching Other Displays

If you prefer to use a monitor or flat panel display, connect it to the DVI-Out Port at the rear of the computer.

1. Attach your external monitor to the DVI-Out Port (or TV to the S-Video-Out jack), and turn it on.
2. Go to Additional Properties in the GeForce Go... Properties control panel tab (see “NVIDIA Display Properties” on page B - 3).
3. Select nView Display Settings (if nView Display Settings do not appear, close and reopen the control panel).
4. Select the display mode from the nView Display Mode drop box (see page B - 12).
5. Select Apply and click Yes to confirm the settings.

Function Key Combination

You can use the F<sub>n</sub> + F7 key combination to toggle through some display options:
- Notebook Only
- External Display Only

Make sure you give the displays enough time to refresh.

Device Settings

Click the display icon to select it, then click the Device Settings button to make any adjustments for the selected display (including Screen Resolutions & Refresh Rates).

Figure B - 8
nView Display Settings

B - 10 Attaching Other Displays
6. Select the display option from the **Primary Display/Secondary Display** dropbox. If you have a TV and external monitor/flat panel display attached you will have a number of available options (see sidebar). Select and **Apply** the appropriate option.

7. Click the monitor icon to select it, and then click the **Device Settings** button to make any adjustments for the selected display (including **Screen Resolutions & Refresh Rates**).

8. Click **Apply** to confirm any setting changes.

---

**nView Display Mode Options**

The display options listed under the **Primary/Secondary display** drop boxes will differ according to the displays attached, and the **Display Mode** chosen.

Click **Detect Displays** (button) to automatically update the attached display information.

---

*Figure B - 9*

**Primary/Secondary Display Dropout**
Display Modes

Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other display(s). This mode will drive multiple displays with the same content and each display device can be configured independently.

Dualview Mode
Dualview Mode treats both connected displays as separate devices, and they act as a virtual desktop resulting in a large workspace. When Dualview is enabled, you can drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the displays, and a different program visible in the other display.
To Enable Extended Desktop (Windows Display Properties)

1. Attach your external monitor to the external monitor port and turn it on.
2. Click **Start**, point to **Settings** (or click **Control Panel**) and click **Control Panel** (if you are in **Category View** choose **Appearance and Themes**).
3. Double-click **Display** (icon).
4. Click **Settings** (tab).
5. Click the monitor icon (e.g. 3), and make sure you have checked “Extend my Windows desktop onto this monitor.” and click **Apply**.

Click the appropriate monitor icon (e.g. 3) to be able to select the option to extend the desktop on to it.

In this example the Primary monitor 1 is on the left, the secondary display 3 is on the right.

Display Settings Extended Desktop

Use the control panel to drag the monitors to match the physical arrangement you wish to use.

You can drag any icons or windows across to either display desktop, which makes it possible to have one program visible in one of the displays, and a different program visible in the other display.

Figure B - 10
Display Properties (Extended Desktop)
Enabling TV Display

To display desktop images on a TV, connect the TV to your computer by using an S-Video cable from the TV to the S-Video-Out jack at the rear of the computer.

You will need to enable the TV display from the nView Display Settings tab (see “Attaching Other Displays” on page B - 10). The TV will appear as a display option (select the display option from the Primary Display/Secondary Display dropbox) when attached to the S-Video-Out jack.

Figure B - 11
TV Device Settings
Click the TV display icon to select it and set the **TV format** from the **Select TV Format menu**. The **Advanced** option at the bottom of the **Select TV Format** menu allows you to select TV format by country if you are unsure of your TV format.

**Device Adjustments** (**Device Settings** menu) allows you to make changes to the **TV output**.

*Figure B - 12
TV Settings & TV Output*
Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed or updated due to the manufacturer’s release schedule. Check with your service center for details.
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor Types</strong></td>
<td></td>
</tr>
<tr>
<td>Mobile AMD Turion™ 64 Processor (35W), 754-pin Micro-PGA Package Models ML-28/ML-32</td>
<td>(μ0.09) 0.09 Micron Silicon-On-Insulator (SOI) Process Technology, 512KB L2 Cache 1.6GHz/ 1.8GHz</td>
</tr>
<tr>
<td>Mobile AMD Turion™ 64 Processor (35W), 754-pin Micro-PGA Package Models ML-30/ML-34/ML-37/ML-40/ML-42/ML-44</td>
<td>(μ0.09) 0.09 Micron Silicon-On-Insulator (SOI) Process Technology, 1MB L2 Cache 1.6GHz/ 1.8GHz/ 2.0GHz/ 2.2GHz/ 2.4GHz</td>
</tr>
<tr>
<td>Mobile AMD Turion™ 64 Processor (25W), 754-pin Micro-PGA Package Models MT-28/MT-32</td>
<td>(μ0.09) 0.09 Micron Silicon-On-Insulator (SOI) Process Technology, 512KB L2 Cache 1.6GHz/ 1.8GHz</td>
</tr>
<tr>
<td>Mobile AMD Turion™ 64 Processor (25W), 754-pin Micro-PGA Package Models MT-30/MT-34/MT-37/MT-40</td>
<td>(μ0.09) 0.09 Micron Silicon-On-Insulator (SOI) Process Technology, 1MB L2 Cache 1.6GHz/ 1.8GHz/ 2.0GHz/ 2.2GHz</td>
</tr>
<tr>
<td>Core Logic</td>
<td>nVIDIA nForce4 SLI Chipset</td>
</tr>
<tr>
<td>LCD</td>
<td>19&quot; WSXGA+ (1680 * 1050) TFT LCD</td>
</tr>
<tr>
<td>Security</td>
<td>Security (Kensington® Type) Lock Slot BIOS Password</td>
</tr>
<tr>
<td>Memory</td>
<td>Two 64-bit wide DDR Data Channels Two 200 Pin DDR SODIMM Sockets Supporting DDR 400/333 MHz Expandable up to 2GB (Compatible with 1024MB, 512MB, 256MB DDR 400/333 MHz Modules)</td>
</tr>
<tr>
<td>BIOS</td>
<td>One 512KB Flash ROM Phoenix BIOS</td>
</tr>
<tr>
<td>Feature</td>
<td>Specification</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Video Card Options</strong></td>
<td><strong>NVIDIA GeForce Go 7800 GTX</strong>&lt;br&gt;Dual/Single NVIDIA G70-GTX High Performance Graphic Chip&lt;br&gt;512MB (Dual VGA) or 256MB (Single VGA)&lt;br&gt;DDR-III (DDR3) Video RAM On Board&lt;br&gt;256 bit Memory Interface&lt;br&gt;PCI Express * 8 by 2&lt;br&gt;Supports DirectX® 9, SM 3.0 (NVIDIA Only)&lt;br&gt;Modular Design</td>
</tr>
<tr>
<td><strong>Storage Options</strong></td>
<td>One Changeable 2.5&quot; 9.5mm (h) <strong>Serial-ATA II (SATA II)</strong> Hard Disk Drive&lt;br&gt;One Changeable Optical Device Bay - 12.7 mm (h) for Optical CD/DVD Device Drive Options (see &quot;Optional&quot; on page C - 5)</td>
</tr>
<tr>
<td><strong>Card Reader</strong></td>
<td>Built-In 4-in-1 Card Reader (SD/ MMC/ MS/ MS Pro)</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td><strong>SRS WOW</strong> Surround Sound Technology&lt;br&gt;Inside&lt;br&gt;3D Enhanced Sound System&lt;br&gt;Sound Blaster PRO™ Compatible</td>
</tr>
<tr>
<td><strong>Keyboard &amp; Pointing Device</strong></td>
<td>Full Size Winkey Keyboard with Numeric Keypad</td>
</tr>
</tbody>
</table>

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.
# Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PCMCIA</strong></td>
<td>One Type II PCMCIA 3.3V/5V Socket</td>
</tr>
<tr>
<td><strong>I/O Ports</strong></td>
<td><strong>PCMCIA</strong></td>
</tr>
<tr>
<td></td>
<td>Five USB 2.0 Ports</td>
</tr>
<tr>
<td></td>
<td>One Mini-IEEE1394a Port</td>
</tr>
<tr>
<td></td>
<td>One Serial Port</td>
</tr>
<tr>
<td></td>
<td>One Infrared Transceiver (IrDA 1.1 / FIR)</td>
</tr>
<tr>
<td></td>
<td>One DVI-Out Port</td>
</tr>
<tr>
<td></td>
<td>One Headphone/Speaker-Out Jack</td>
</tr>
<tr>
<td></td>
<td>One Microphone-In Jack</td>
</tr>
<tr>
<td></td>
<td>One S/PDIF Out Jack</td>
</tr>
<tr>
<td></td>
<td>One Line-In Jack for Audio Input</td>
</tr>
<tr>
<td></td>
<td>One RJ-11 Jack (Modem)</td>
</tr>
<tr>
<td></td>
<td>One RJ-45 Giga LAN (Local Area Network) Jack</td>
</tr>
<tr>
<td></td>
<td>One DC-In Jack</td>
</tr>
<tr>
<td></td>
<td>One 7-Pin S-Video-Out Jack for TV &amp; HDTV Output (requires adapter)</td>
</tr>
<tr>
<td></td>
<td>One TV Antenna (Analog/Digital) Jack (Functions with Optional TV Tuner Module)</td>
</tr>
<tr>
<td></td>
<td>One Consumer Infrared Transceiver (Functions with Optional TV Tuner Module)</td>
</tr>
<tr>
<td></td>
<td>One S-Video-In Jack for Video Input (Functions with Optional TV Tuner Module)</td>
</tr>
<tr>
<td><strong>Communication</strong></td>
<td><strong>PCMCIA</strong></td>
</tr>
<tr>
<td></td>
<td>Infrared Transceiver</td>
</tr>
<tr>
<td></td>
<td>Infrared Transfer 1cm ~ 1M Operating Distance</td>
</tr>
<tr>
<td></td>
<td>115.2K bps SIR</td>
</tr>
<tr>
<td></td>
<td>4M bps FIR</td>
</tr>
<tr>
<td></td>
<td>IrDA 1.1 Compliant</td>
</tr>
<tr>
<td></td>
<td>10/100/1000 BASE-TX Fast Ethernet LAN on board (PCIe Interface)</td>
</tr>
<tr>
<td></td>
<td>Integrated 56K AC’97 Modem (V.92 Compliant)</td>
</tr>
<tr>
<td>Feature</td>
<td>Specification</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Operating Systems Supported</strong></td>
<td>Windows XP SP2</td>
</tr>
<tr>
<td><strong>Power Management</strong></td>
<td>Supports ACPI 2.0</td>
</tr>
<tr>
<td>Supports Hibernate/Stand by Modes</td>
<td></td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>Full Range AC/DC Adapter – AC in 100 ~ 240V, 47 ~ 63Hz DC Output 20V, 11 A (220 Watts)</td>
</tr>
<tr>
<td>Easy Changeable 12-Cell Smart Lithium-Ion 6600mAH / 14.8V Main Battery</td>
<td></td>
</tr>
<tr>
<td><strong>Environmental Spec</strong></td>
<td><strong>Temperature</strong></td>
</tr>
<tr>
<td>Operating:</td>
<td>5°C ~ 35°C</td>
</tr>
<tr>
<td>Non-Operating:</td>
<td>-20°C ~ 60°C</td>
</tr>
<tr>
<td><strong>Relative Humidity</strong></td>
<td>Operating:</td>
</tr>
<tr>
<td></td>
<td>20% ~ 80%</td>
</tr>
<tr>
<td>Non-Operating:</td>
<td>10% ~ 90%</td>
</tr>
<tr>
<td><strong>Physical Dimensions &amp; Weight</strong></td>
<td>476mm (w) * 343mm (d) * 29.5 ~ 47.8mm (h)</td>
</tr>
<tr>
<td></td>
<td>6.6kg with 12-Cell Battery</td>
</tr>
<tr>
<td><strong>Optional</strong></td>
<td><strong>Optical Drive Module Options:</strong></td>
</tr>
<tr>
<td>DVD/CD-RW Combo Drive Module</td>
<td>TV Tuner Module (either analog only OR analog/digital options) with Mini-PCI Interface (Factory Option)</td>
</tr>
<tr>
<td>DVD-Dual Drive Module</td>
<td>1.3M Pixel USB 2.0 Video Camera Module (Factory Option)</td>
</tr>
<tr>
<td>DVD-Super Multi Drive Module</td>
<td>DVD Software Player</td>
</tr>
</tbody>
</table>